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1 UNDERSTANDING THE CANOPY T1/E1 
MULTIPLEXER 

1.1 USING THIS USER GUIDE 
This guide should be used with Canopy T1/E1 Multiplexer FPGA Version 3.4. The 
audience for this document includes system operators, network administrators, and 
equipment installers. 

1.1.1 New in This Issue 
Issue 3 of this user guide is published to state the requirement that an external surge 
suppression device must be used with the AC adapter supplied by Canopy for the T1/E1 
Multiplexer, and to specify the recommended standard. The following elements of this 
document are affected: 

◦ Introduction to Canopy T1/E1 Multiplexer on Page 9 
◦ beneath Figure 3 on Page 12 
◦ Power Adapters on Page 18 
◦ Lightning Protection on Page 27 
◦ Power Supply Unit on Page 27 
◦ Procedure 3 on Page 31 

Also in Issue 3, Preparing for Installation and Setup on Page 28 clarifies how Ethernet 
cables must be selected. 

1.1.2 Using the Latest Information 
When Canopy T1/E1 Multiplexers are shipped, the latest issue of this document is 
included on CD-ROM with the shipment. However, the latest issue at any time is 
available on the Canopy web site: http://www.motorola.com/canopy, posted among the 
user guides that support other Canopy products. 

You can distinguish the latest information by the issue number on the cover and in page 
footers. The above section, New in This Issue, lists the significant changes that were 
made to the document since the previous issue. Check that section before you proceed 
to the information for which you are visiting the document. 

1.1.3 Searching This User Guide 
To search this document, look in 

◦ the Table of Contents for the topic. 
◦ the Adobe Reader® search capability for keywords that apply.1  

1.1.4 Interpreting Typeface and Other Conventions 
This document employs distinctive fonts to indicate the type of information, as described 
in Table 1. 

                                                      
1 Reader is a registered trademark of Adobe Systems, Incorporated. 

Issue 3 
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Table 1: Font types 

Font Type of Information 

variable width bold 
Selectable option in a graphical user interface or settable 
parameter in the web-based interface to a Canopy 
component. 

constant width regular Literal system response in a command-line interface. 

constant width italic Variable system response in a command-line interface. 

constant width bold Literal user input in a command-line interface. 

constant width bold italic Variable user input in a command-line interface. 
 

This document also employs a set of consistently used admonitions. Each of these types 
of admonitions has a general purpose that underlies the specific information in the box. 
These purposes are indicated in Table 2. 

Table 2: Admonition types 

Admonition 
Label General Message 

� 

NOTE: 
informative content that may 

◦ defy common or cursory logic. 
◦ describe a peculiarity of the Canopy implementation. 
◦ add a conditional caveat. 
◦ provide a reference. 
◦ explain the reason for a preceding statement or provide prerequisite 

background for what immediately follows. 

 

RECOMMENDATION: 
suggestion for an easier, quicker, or safer action or practice. 

 

IMPORTANT! 
informative content that may 

◦ identify an indication that you should watch for. 
◦ advise that your action can disturb something that you may not want 

disturbed. 
◦ reiterate something that you presumably know but should always 

remember. 

Issue 3 
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Admonition 
Label General Message 

  
CAUTION! 
a notice that the risk of harm to equipment or service exists. 
 

 

WARNING! 
a notice that the risk of harm to person exists.  

 

1.1.5 Getting Additional Help 
Help is available for problems with supported products and features. The sequence of 
actions that you should take if these problems arise is provided under Obtaining 
Technical Support on Page 65. 

1.1.6 Sending Feedback 
We welcome your feedback on Canopy system documentation. This includes feedback 
on the structure, content, accuracy, or completeness of our documents, and any other 
comments you have. Please send your comments to  
technical-documentation@canopywireless.com. 

1.2 INTRODUCTION TO CANOPY T1/E1 MULTIPLEXER 
This user guide provides the installation and configuration requirements for the Canopy 
T1/E1 Multiplexer, a modular gateway that works with Canopy Backhaul Modules to 
enable up to four T1 (or up to three E1) circuits to be extended over Ethernet networks.   
The Canopy T1/E1 Multiplexer is available in two power configurations: 

◦ an external 3.3-v DC power source from a 120/240-v AC adapter (supplied  
by Canopy) 

  

WARNING! 
An external AC surge suppression device must be used with the Canopy 
T1/E1 Multiplexer. For infrastructure installations, Canopy Engineering 
recommends an AC line surge suppression unit that meets the standard 
IEC 801-5 (EN61000-4-5) Maximum Surge Voltage (1.2x50µsec) 6 KV. 

 

◦ a connection to an external −48 v DC supply. 
The Canopy T1/E1 Multiplexer is illustrated with Canopy Backhaul Modules (BHs) in 
Figure 1. 

Issue 3 
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Figure 1: Canopy T1/E1 Multiplexer with Canopy BHs 

 

The T1/E1 Multiplexer converts the data stream from T1/E1 ports into Ethernet packets 
that are then transported over the Canopy BH link. This device can be used to extend 
T1/E1 services. You can configure the Canopy T1/E1 Multiplexer to operate as either a 
T1 or an E1 device. 

Applications of the T1/E1 Multiplexer include 

◦ obviating leased lines. 
◦ implementing wireless PBX networking. 
◦ establishing cellular backhaul links. 
◦ providing homeland security backup or emergency voice networks. 
◦ routing LAN/WAN data on excess bandwidth. 

1.2.1 Ethernet Interface 
The Ethernet physical layer auto-negotiation should be set to on for both sides of the 
Canopy T1/E1 Multiplexer. 

RJ-45 connector pin-outs for the Ethernet cable from the BH to the Canopy port of the 
Canopy T1/E1 Multiplexer are illustrated in Figure 12 on Page 30. 

Issue 3 
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1.2.2 Standards 
The Canopy T1/E1 Multiplexer conforms to the following standards: 

◦ G.703 ◦ TR-AT&TG2411 
◦ G.823 ◦ IEEE 802.3 
◦ G.824 ◦ EMC Class A compliance – EN 55022 Class A
◦ ANSI T1.403  

1.2.3 IDU Physical Description 
The unit provides a compact, simple to configure, and easily scalable solution for 
transporting T1/E1 services over Canopy wireless Ethernet-based networks. 

1.2.4 Rear Panel 
Interface connections and the power port are located on the rear panel of the unit. 

 
Figure 2: Canopy T1/E1 Multiplexer rear panel 

 

Issue 3 
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Figure 3: Rear panel with standard 110-v source power supply 

 

  

WARNING! 
An external AC surge suppression device must be used with the Canopy 
T1/E1 Multiplexer. For infrastructure installations, Canopy Engineering 
recommends an AC line surge suppression unit that meets the standard 
IEC 801-5 (EN61000-4-5) Maximum Surge Voltage (1.2x50µsec) 6 KV. 

 

 

 

Figure 4: Standard adapters for global use 

 

Issue 3 
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Figure 5: Rear panel with optional −48 v power supply adapter for battery backup 

 

The recommended sequence of connection is: 

1. Connect a PBX or TDM CPE to the T1/E1 port(s). (See Figure 2 on Page 11.) 
2. Connect the Ethernet cable from the Canopy Backhaul Module to the jack 

labeled Canopy. (See Figure 2 on Page 11.) 
3. Connect the selected power adapter to the T1/E1 Multiplexer. (See Figure 3 and 

Figure 4.) 
4. Power the T1/E1 Multiplexer on. (See Figure 3.) 
5. As required to configure the T1/E1 Multiplexer, connect a notebook computer to 

the jack labeled CONTROL on the front panel of the T1/E1 Multiplexer. (See 
Figure 6.) 

Issue 3 
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1.2.5 Front Panel 
The control port and indicator LEDs are located on the front panel of the unit. 

 

 

Figure 6: Canopy T1/E1 Multiplexer front panel 

Status LEDS 

The status indicator LEDS on the front of the Canopy T1/E1 Multiplexer are listed in 
Table 3. 

Table 3: LED status indicator descriptions  

LED  LED indicator descriptions 

PWR ON when main power supply is OK; OFF when a malfunction is 
detected 

RDY ON when self-test is successfully completed; OFF during self-test; and 
BLINKING when self-test fails  

CANOPY LINK OFF when line is not active; ON when Canopy BH Ethernet line is OK  

CANOPY ACT OFF when no activity; BLINKNG when frames are being transmitted or 
received on the line  

LAN LINK OFF when line is not active; ON when line is OK 

Issue 3 
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LED  LED indicator descriptions 

LAN ACT OFF when no activity; BLINKING when frames are being transmitted or 
received on the line 

T1/E1 Sync ON when the port is synchronized (no alarm); OFF when Loss of signal 
(LOS); one LED for each T1/E1 

1.2.6 Features  
The Canopy T1/E1 Multiplexer 

◦ installs easily. 
◦ multiplexes up to 4 T1 or 3 E1 circuits onto a Canopy Backhaul point-to-point 

link. 
◦ enables T1/E1 extension over Ethernet networks. 
◦ supports  

− synchronous TDM-based services over wireless Ethernet networks. 
− CAS signaling transparent to all other signaling protocols on T1/E1. 
− 10Base-T/100Base-TX uplink to the network. 
− management interfaces. 
− simplified troubleshooting through T1/E1 line loopback test. 

1.2.7 Specifications 
Physical Specifications 

Table 4 lists the physical specifications for the Canopy T1/E1 Multiplexer. 

Table 4: Canopy T1/E1 Multiplexer physical specifications 

Specification Description 

Option 1: 100/240 v, 47−63 Hz, 0.4 A (+3.3 v DC) DC Power 

Option 2: −48 v DC  

LAN Connection 2-100Base-TX, RJ-45 cable provided 

T1/E1 Connections 4 

Control Port RS-232, DB9 (female) 

Indicators power, ready, Canopy BH Ethernet link; Canopy BH Ethernet 
activity; LAN Ethernet link; LAN Ethernet activity; T1/E1 
synchronization (one per port) 

Temperature 0° C to 40° C 

Humidity 95% non-condensing 

Dimensions 1.52” (3.86 cm) high x 5.57" (14.15 cm) wide and 7.50" (19.05 cm) 
deep 

Weight 1.5 pounds (680 grams) 

Issue 3 
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Technical Specifications 

The following tables list the technical specifications for the Canopy T1/E1 Multiplexer. 

Table 5: T1 port specifications 

Specification Description 

Ports 1, 2, 3, and 4 

Compliance ANSI T1.403 

Connector RJ-45, 8-pin 

T1 Data Rate 1.55 Mbps 

T1 Line Code B8ZS, AMI 

Line Impedance Balanced: 100 ohms 

Signal levels Receive: 0 to -27 dB 
Transmit: +2.7 v + 10%, adjustable, measured in range 0 to 655 feet.

Jitter Performance AT&T TR-62411, G.824 Standards 

 

Table 6: T1 framing specifications 

Specification Description 

Compliance ANSI T1.403 

Framing D4, ESF (transparent) 

Signaling CAS (Robbed bit signaling); CCS (transparent) 
 

Table 7: E1 port specifications 

Specification Description 

Ports 1, 2, and 3 

Compliance ITU-T G.703 

Connector RJ-45, 8-pin 

E1 Data Rate 2.048 Mbps 

E1 Line Code HDB3, AMI 

Line Impedance Balanced: 120 ohms

Signal levels Receive: Per G.703
Transmit: Per G.703 

Jitter Performance ITU-T G.823 
 

Issue 3 
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Table 8: E1 framing specifications 

Specification Description

Compliance ITU-T G.703

Framing transparent 

Signaling transparent 
 

Table 9: Local terminal and control interface specifications 

Specification Description 

Type RS-232 via DB-9 Female Connector

Mode DTE 

Baud Rate 19.2 kbps 

1.3 CONFIGURATION SETTINGS FROM CANOPY FACTORY 

1.3.1 Bit Handling Capability 
As shipped, Canopy T1/E1 Multiplexers transparently pass all T1 or E1 bits regardless of 

◦ user framing as 
− D4 
− Extended Superframe (ESF) 

◦ user encoding as 
− AMI 
− B8ZS 
− HDB3 

However, user encoding is helpful for generating meaningful bipolar variation (BPV) data. 
Canopy T1/E1 Multiplexers are factory preset to the B8ZS encoding for T1, though easily 
changed to another encoding scheme, and are preset as master or slave for timing. 

NOTE: To receive the highest level of performance from these units, the user should 
understand 

◦ clock recovery timing. 
◦ packet/frame loss concepts. 
◦ delay and latency. 
◦ jitter. 

Issue 3 
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1.3.2 License Keys 
Each Canopy T1/E1 Multiplexer is purchased and shipped as 1-port enabled or 4-port 
enabled. You can upgrade any pair of 1-port enabled Canopy T1/E1 Multiplexers through 
the purchase and installation of 

◦ two keys, one per unit, to transform both to 2-port enabled. 
◦ four keys, two per unit, to transform both to 3-port enabled. 
◦ six keys, three per unit, to transform both to 4-port enabled. 

1.3.3 Power Adapters 
For connection to power sources, the 110-volt power supply pictured in Figure 3 on  
Page 12 and the global adapter set pictured in Figure 4 on Page 12 are included with the 
purchase of each Canopy T1/E1 Multiplexer.  

 

  

WARNING! 
An external AC surge suppression device must be used with the Canopy 
T1/E1 Multiplexer. For infrastructure installations, Canopy Engineering 
recommends an AC line surge suppression unit that meets the standard 
IEC 801-5 (EN61000-4-5) Maximum Surge Voltage (1.2x50µsec) 6 KV. 

 

The −48 v screw-down adapter for battery backup pictured in Figure 5 on Page 13 is an 
option. 

1.4 PRODUCT LABELS 
Labels on the Canopy T1/E1 Multiplexer include 

◦ ESN — Electronic Serial Number, the Media Access Control (MAC) address 
◦ MSN — Model Serial Number, which allows tracking of the product 
◦ Factory Configuration, which identifies the product as 

− Master Unit or Slave Unit 
− 1-Port Unit or 4-Port Unit 

1.5 FUNCTIONAL DESCRIPTION OF THE CANOPY T1/E1 MULTIPLEXER 
The Canopy T1/E1 Multiplexer has a LAN Ethernet port, a Canopy Backhaul Module 
Ethernet port, and four ports as follows: 

◦ up to four available when the unit is configured for the T1 transmission scheme. 
◦ up to three available when the unit is configured for the E1 transmission scheme 

(to support Canopy BH20 Backhaul link traffic). 
Configuration and management are provided using the command line interface (CLI) or 
EMS GUI. 

Issue 3 
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1.5.1 Channel Modes 
T1 Channel Mode 

While in T1 mode, the Canopy T1/E1 Multiplexer operates as a DSX-1 interface in a DSU 
channel mode.  There are no user options to change this mode. The DSU channel mode 
can operate within five line lengths, each providing compensation for the length of the T1 
line.  The line lengths are: 

◦ 0-133 ft. / 0.6dB 
◦ 134-266 ft. / 1.2dB 
◦ 267-399 ft. / 1.8dB 
◦ 400-533 ft. / 2.4dB 
◦ 534-655 ft. / 3.0dB 

E1 Channel Mode 

While in E1 mode, the transmit line build-out meets the short haul requirements specified 
in Recommendation ITU G.703. 

1.5.2 Encoding 
The Canopy T1/E1 Multiplexer transparently passes all T1/E1 bits, including framing, 
encoding and zero suppression, through to the far end T1/E1 using the Canopy BH 
Module Ethernet port.   

For T1 mode, no user settings are required for D4 or Extended Superframe (ESF) 
framing types, or for T1 signaling bits.  Both 56-kbps and 64-kbps channels are 
transparently passed.  The user must identify which type of T1 is being used; Alternate 
Mark Inversion (AMI) or Binary Eight Zero Substitution (B8ZS) in order for the Canopy 
T1/E1 Multiplexer to properly ascertain bipolar violations (BPV).  A bipolar violation is a 
non-zero signal element in an AMI signal that has the same polarity as the previous non-
zero signal element.   

For T1 mode, the Canopy T1/E1 Multiplexer supports the following: 

◦ Transparent support of the T1 channel, including 
− D4 
− Extended Superframe (ESF) 
− 56-kbps and 64-kbps channels 
− Zero suppression  

◦ AMI 
◦ B8ZS 
◦ up to four ports 

 
For E1 mode, no user settings are required for framing types or for E1 signaling bits.  The 
user must identify which type of E1 is being used; Alternate Mark Inversion (AMI) or High 
Density Binary Three Bit Zero Substitution (HDB3) in order for the Canopy T1/E1 
Multiplexer to properly ascertain bipolar violations (BPV).  A bipolar violation is a non-
zero signal element in an AMI signal that has the same polarity as the previous non-zero 
signal element.   
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For E1 mode, the Canopy T1/E1 Multiplexer supports the following: 

◦ Transparent support of the E1 channel  
◦ AMI 
◦ HDB3 
◦ up to three ports 

 

Alternate Mark Inversion (AMI)  

The template of the DS-1 signal is bipolar. This means that a plus voltage, a zero voltage, 
and a minus voltage are important to the coding of the signal. The code that is used in T1 
is called Alternate Mark Inversion (AMI). The requirement is that if a “1” (or Mark) is 
coded as a positive voltage, the very next “1” must be coded as a minus voltage or the 
result will be a bipolar violation (BPV). Another one of the requirements of the coding 
sequence is that a “1” bit is sent to maintain the timing synchronization. A signal that is 
sending all “0s” would be a constant zero voltage line. The eventual result would be that 
the system’s timing would be lost.  In order to overcome the potential situation where a 
string of  “0s” causes a loss of the system’s timing, a number of zero suppression 
techniques have been designed.  Common techniques are used to handle zero 
suppression requirements are: 

◦ 1 in 15 Requirement 
◦ B8ZS. 
◦ HDB3 

 

The Canopy T1/E1 Multiplexer fulfills the role of a transparent T1/E1 extender. As such, it 
is compatible with either AMI, B8ZS, or HDB3 coding of signals. The endpoints determine 
which of the zero suppression techniques will be applied to the signal. The Canopy T1/E1 
Multiplexer must be set to match the zero suppression settings at the endpoints of the 
signal.  

The 1 in 15 Requirement (AMI) 

The 1 in 15 requirement stipulates that no more than 15 “0s” may be sent be for every “1” 
that is transmitted. The easiest approach is to make every bit 8 a “1” and to use only the 
lower 7 bits for data transmission. This 7/8 mode yields a rate of 56 kbps instead of the 
standard DS-0 rate of 64 kbps. This technique also prevents the use of signaling bits 
since bit 8 is now used for a different purpose. 

Configuring the Canopy T1/E1 Multiplexer to AMI accommodates the stipulations for bit 
handling identified in the 1 in 15 requirement.  

Binary Eight Zero Substitution Coding  

The limitations imposed by the 1 in 15 requirement led to the development of Binary Eight 
Zero Substitution (B8ZS) coding. This signal coding technique takes advantage of BPVs 
in the data stream to be decoded as signal. With B8ZS coding, each block of eight 
consecutive zeros is replaced with the B8ZS code word. The transmitted bit stream will 
contain two AMI violations. 
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The receiver will use these violations for synchronization. The receiver recognizes that 
the transmitted bit stream containing the two AMI violations is not true data. The B8ZS is 
the standard for “Clear Channel Capability” and is part of ANSI.T1.403-1989.  

High Density Bipolar Order Three Encoding  

High Density Bipolar Order 3 Encoding (HDB3) is a bipolar signaling technique that is 
based on Alternate Mark Inversion (AMI).  It inserts bipolar violations (BPVs) whenever 
there is a string of 4 or more zeros.  The “violation” bit has the same polarity as the last 1-
bit which was sent using AMI encoding.  The receiver removes all “violation” bits. 

You may select the coding for the Canopy T1/E1 Multiplexer using either the T1/E1 EMS 
or the CLI manager.  

1.5.3 Signaling 
All voice and data channel signaling passes transparently between endpoints through the 
Canopy T1/E1 Multiplexer.  

1.5.4 Timing 
T1/E1 circuits are synchronous. This means that the T1/E1 circuits must be synchronized 
or clocked with each other. Failure to do so may result in frame slips. The consequence 
for which could be a degradation of quality. The clock for a T1/E1 circuit is normally 
derived from the incoming T1/E1 signal.  T1/E1 circuits are typically connected in a 
master-slave configuration where the master has more accuracy than the slave.  A clock 
in a telecommunications system or network has a quality level or stratum number 
assigned to it. This number indicates the clock’s quality and position in the timing 
hierarchy. This position is determined by the clock’s stability.  The more accurate clocks 
are listed at the top of the hierarchy.  A conventional hierarchy for T1 is defined and is 
used by Local Exchange Carriers (LECs).  This hierarchy is called a (Building Integrated 
Tuning Supply (BITS) hierarchy and the formal specifications and standards for this 
hierarchy are given in the ANSI standards T1.101-1999 and T1.105.09-1996. 

The highest quality clocks are called Stratum 1 clocks. These clocks have a frequency 
offset of 1x10-11 or less. This means that Stratum 1 clocks are accurate to within 1 
microsecond over a 24-hour period. Stratum 1 clocks are typically Cesium-beam clocks, 
but the newer GPS-referenced rubidium clocks have been shown to achieve better than 
1x10-12 frequency offset at any time.  The next level of clocks is Stratum 2 clocks. 
Stratum 2 clocks have a 1x10-10 frequency offset and are typically used at toll centers.  
Class 5 Central Offices (COs) use Stratum 3 clocks. Stratum 3 clocks have a frequency 
offset of 3.7x10-7.  Stratum 3 clocks have less than 255 T1 slips in 24 hours.  Stratum 4 
clocks have a frequency offset of 3.2x10-6 and are found at customer premises 
equipment (CPE) in PBXs, channel banks, and routers.  Stratum 4 clocks have no hold-
over capability and are used to smooth out jitter and wander and provide a clean clock 
source for customer data.  They accomplish this through clock recovery from higher-order 
T1 clocks from the Class 5 COs or through an internal clock that is running at Stratum 4.   

The Canopy T1/E1 Multiplexer does not have an internal clock. Therefore, it must be set 
to synchronize to an incoming T1/E1 clock source.  Each network node’s (PBX, Channel 
Bank, Router) clock is based on the best available clock source for it.  If multiple clocks 
are available with the same quality, then the source that is the closest, in number of hops, 
is chosen. 
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Table 10: Frequency off-set by clock type  

 
Clock 
Type 

Frequency Off-set 
(accuracy over 24 

hours) 

 
Time to First 
Frame Slip 

 
 

Application 

Stratum 1 
Clock 

1 x10-11 1 every 72 days Gateway Office 

Stratum 2 
Clock 

1x10-10 1 every 3.5 hours Toll Center  

Stratum 3 
Clock 

3.7x10-7 1 every 6 minutes  
or  
255 in 24 hours 

Central Office 

Stratum 4 
Clock 

3.2x10-6 Up to 1 frame slip 
every 4 seconds in 
free-run 

Customer Premises Equipment 
(PBX, Channel Banks, Routers) 

 

The Canopy T1/E1 Multiplexer does not have an internal oscillator. Therefore, the unit 
must be synchronized to a T1/E1 bit stream in order to accurately pass T1/E1 traffic.  The 
Canopy T1/E1 Multiplexer may be configured to synchronize to a near-end or far-end 
Canopy T1/E1 Multiplexer. 

Master and Secondary Clocks 

The clock on each Canopy T1/E1 Multiplexer must be correctly configured to prevent 
frame slips.  Each of the four (4) T1/E1 ports may be configured as the Master clock 
source or the Secondary clock source.  Any port may be set to Master and any port may 
be set to Secondary, however there may only be one (1) Master and one (1) Secondary 
clock setting per unit.   

Note: If neither the Master or Slave port is active, then the system will start at Port 1 and 
search in logical order until it finds an active T1/E1 port, at which time it will assume this 
to be the Master clock source.   

Two scenarios are shown below, one scenario with Port 1 set to Master and Port 2 set to 
Secondary. The second scenario shows Port 1 set to Secondary and Port 3 set to 
Master. 

 

Figure 7: Master and secondary clock settings (top view) 
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Loss of Clock Signal  

Should the Master port not be able to track the incoming T1/E1 bit stream due to a loss of 
signal, then the unit will use the Secondary port as the clock source.  Once the Master T1 
recovers synchronization by locking onto the signal, the unit will revert to using the 
Master port as the clock source. 

Timing Modes 

Each T1/E1 interface port that is in use must have clocking configured to avoid potential 
frame slips.  All T1/E1 interface ports have an identical global timing mode. There are two 
timing modes for the Canopy T1/E1 Multiplexer, namely Loopback and Recovery modes. 

Loopback mode:  the T1/E1 Transmit clock (transmit from the Canopy T1/E1 Multiplexer) 
is derived from the incoming Receive clock on the T1/E1. 

Recovered mode:  the T1/E1 Transmit clock (transmit from the Canopy T1/E1 
Multiplexer) is derived from the far-end device’s transmit clock (the far end Canopy T1/E1 
Multiplexer Receive clock).  In this mode, a buffer is used to accommodate bursts of 
Ethernet traffic.  The buffer is, on average, maintained at a constant level.  As the buffer 
fills, the Transmit clock increases in frequency to avoid overflow.  As the buffer empties, 
the Transmit clock decreases in frequency in order to maintain a constant level.   

Note:  when the system is set to Recovered Timing Mode, the derived clock is 
susceptible to Packet Delay Variation (PDV) and may not comply with jitter and wander 
specifications. 

Loopback Timing Mode 

Loopback Timing Mode takes the incoming Transmit clock from a network device, such 
as a PBX, and derives the clock signal from that device for the outgoing Receive clock 
(PBX receive clock). 

 

 

 

 

 

 

 

 

Figure 8: Master timing set to Loopback mode 

 

Recovered Timing Mode  

Recovered Timing Mode takes the incoming Ethernet bit stream from the BH link and 
derives the clock signal from the incoming bit stream for the outgoing Receive clock (PBX 
receive clock). 
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Figure 9: Slave timing set to Recovered mode 

 

Network Timing Scenarios 

Typically, when connecting two T1 devices, one end is set as the master clock source 
and the other end is set as the slave clock source.  The slave device takes the timing 
information from the master clock source. The slave device then synchronizes its clocks 
with the master.  This is shown in Figure 10. 

 

 

Figure 10: Network timing scenarios 

 

When a Canopy T1/E1 Multiplexer is inserted between two T1 devices, the clocking 
should be configured in the same manner as it would be without the Canopy T1/E1 
Multiplexer. For example, when the Canopy T1/E1 Multiplexer is inserted between the 
two PBXs, the one PBX will remain as the master clock source and the other PBX will 
remain as the slave clock source.  The Canopy T1/E1 Multiplexer should be configured in 
the following manner: 

◦ The Canopy T1/E1 Multiplexer connected to the master clock source should be 
configured in Loopback Timing Mode. The unit will take the clock signal from the 
PBX master clock source on the PBX transmit side, derive the clock and then 
send it back to the PBX on the receive side. 

◦ The Canopy T1/E1 Multiplexer connected to the slave clock source should be 
configured in Recovery Timing Mode.  It will derive a clock signal from the 
incoming bit stream from the WAN side and pass it on to the slave PBX. 
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In a scenario where T1/E1 devices are configured with an external master clock source, 
each Canopy T1/E1 Multiplexer should be configured in Loopback Timing Mode.  Each 
Canopy T1/E1 Multiplexer will take the timing signal from the incoming T1/E1, derive the 
clock and then return the clock to the T1/E1 device.  The external clock source may be 
obtained from any number of sources including Carrier services, GPS, or other high-
quality clock source.   

For example, each of the two PBXs might have a SONET connection from the local 
telephone company operator. This connection would be used as the master clock source 
for both PBXs.  Alternatively, each PBX could have a Stratum 3 clock source from the 
same Central Office, or could be connected to GPS receivers. 

1.5.5 Ethernet Throughput 
The Ethernet port to the Canopy BH module is a 100-Mbps full duplex port, transmitting 
at a throughput rate that does not cause buffer overload in the Canopy modules.  The 
LAN side Ethernet port, connected to the customer LAN, also transmits at 100 Mbps full 
duplex.  The Canopy T1/E1 Multiplexer will insert T1/E1 traffic into the Ethernet bit 
stream and therefore the Ethernet throughput will be reduced by approximately 2 Mbps 
for each T1/E1 that is programmed.  

The rates for Ethernet throughput for each programmed T1/E1 connection are displayed 
in Table 11. 

Table 11: Canopy BH20 Ethernet throughput for programmed T1/E1 connections 

Active 
T1/E1  
Channels 

Ethernet Half-duplex 
Throughput on LAN  
Port in T1 mode. 

Ethernet Half-duplex 
Throughput on LAN  
Port in E1 mode. 

1 5.4 Mbps 5.4 Mbps 

2 4.1 Mbps 2.66 Mbps 

3 2.34 Mbps 24 Kbps 

4 240 Kbps N/A* 

 
* Due to the bandwidth limitations of the Canopy BH, only 3 E1 channels can be 
used. 

� 
NOTE: 
The maximum packet rate in T1 mode is 666 packets/sec.  The 
maximum packet rate in E1 mode is 442 packets/sec. Maximum 
Ethernet rate occurs when using 1518-byte packet streams. 
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1.5.6 VLAN Support 
The Canopy T1/E1 Multiplexer fully supports customer VLAN traffic.  The Canopy T1/E1 
Multiplexer has an increased maximum Ethernet packet size of 1600 bytes.  Typically, 
the maximum packet size is 1518 bytes for Ethernet traffic, however VLAN traffic adds an 
extra 4 bytes for the VLAN tag as in the 802.1Q protocol.  In addition, some 
manufacturers, such as Cisco, have proprietary VLAN applications that result in extra 
long Ethernet packets. 

1.5.7 Round‐Trip Packet Delay 
The one-directional delay between the two T1/E1 endpoints would be approximately 20 
milliseconds. This delay does not include any delay added by Canopy Backhaul Modules. 
The Ethernet throughput delay is the time required for one Ethernet packet to pass 
through the LAN port of the Canopy T1/E1 Multiplexer. The maximum one-directional 
delay for an Ethernet packet of size 1518 Bytes is approximately 240 microseconds, 
excluding the delay that Canopy BH modules introduce. 

1.5.8 Alarms 
The Canopy T1/E1 Multiplexer supports the Alarm Indication Signal (AIS).  It is sent 
under 2 conditions: a loss of incoming T1/E1 signal (in which case AIS is sent out to the 
far end and the same for the other end losing T1/E1 signal) and a loss of BH link (in 
which case the AIS is sent in both directions). 
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2 INSTALLING AND CONFIGURING YOUR CANOPY 
T1/E1 MULTIPLEXERS 

2.1 SAFETY INFORMATION 

2.1.1 Compliance 
It is the responsibility of the installer to be sure that all building and safety codes are met 
and that the installation is complete and secure. 

For Canadian installations, the entire equipment installation must comply with Canadian 
Standard CSA 22.2, No. 60950, Safety of Information Technology Equipment. For 
installations in the United States, the entire equipment installation must be in accordance 
with Article 810 of the United States National Electrical Code. 

2.1.2 Lightning Protection 
When installed, this equipment is to be connected to a Lightning/Surge Protection Device 
that meets all applicable national safety requirements. See Power Supply Unit on  
Page 27. 

2.1.3 Electrocution Hazard 
 

  

WARNING! 
Electrocution Hazard 

 

This product is intended to be connected to either a 3.3-v DC power source (supplied by 
Canopy) or an external −48 v DC supply, which must be electrically isolated from any AC 
sources and reliably connected to ground (Protective Earth). Do not install Canopy 
products near any type of power line. If any related hardware contacts a power line, 
severe bodily harm or death could result! 

2.1.4 Power Supply Unit 
 

  

WARNING! 
An external AC surge suppression device must be used with the Canopy 
T1/E1 Multiplexer. For infrastructure installations, Canopy Engineering 
recommends an AC line surge suppression unit that meets the standard 
IEC 801-5 (EN61000-4-5) Maximum Surge Voltage (1.2x50µsec) 6 KV. 
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WARNING! 
Substitution of the power supply may impair intrinsic safety.  The  
Canopy T1/E1 Multiplexer must be used with Model Number TR10R033 
manufactured by Cincon Electronics Co., Ltd. 

 

2.2 INSTALLATION PROCEDURES 

2.2.1 Package Contents   
 
Verify the contents shipped against the packing list for the box. You should have received 
the following: 

◦ T1/E1 unit 
◦ AC Power supply (Option 1 only) 
◦ CD ROM (EMS GUI and the software download application) 

2.2.2 Preparing for Installation and Setup 
Select the appropriate type of cable for connection to the Ethernet port of the Canopy 
T1/E1 Multiplexer as follows:  

◦ For connection to a LAN or a switch, a straight-through cable is required.  
◦ For connection to the NIC card in a PC, a crossover cable is required. 
◦ For connection to a PBX, a T1/E1 crossover cable is likely required. Refer to your 

PBX installation instruction manual for specific requirements. 

2.2.3 Mounting the Canopy T1/E1 Multiplexer 
Mounting option for the unit is either a desk mount or a rack mount. Follow this procedure 
to affix the until to a rack mount: 

Procedure 1: Affixing the Multiplexer to a rack mount 

Remove the Front Panel by removing Front Panel Mounting Screws. 
1. Remove the two screw posts from the DB-9 connector. 
2. Remove Front Bezel and set aside. 
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Figure 11: Front panel and front bezel removed 

3. Place the Canopy T1/E1 Multiplexer behind the desired Rack Panel mounting 
hole.   
NOTE: The Rack Panel will support three (3) Canopy T1/E1 Multiplexers. 

4. Place the Front Panel on the front of the Rack Panel opening, positioning the 
Rack Panel Spacer between the two panels.  

5. Insert the front panel mounting screws through the screw holes.  
6. Tighten screws. 
7. Insert the screw posts onto the DB-9 connector. 
8. Tighten screw posts. 
9. Mount the Canopy T1/E1 Multiplexer with the rack panel onto your rack unit. 

Consult the product information supplied by the rack manufacturer for details. 
NOTE: The front panel mounting screws should be 4-40 screws, between 3/8” 
and 5/8” long. 

 end of procedure 

2.2.4 Connecting the Canopy T1/E1 Multiplexer 

Table 12: T1/E1 port connector pin-out 

Pin Designation Direction Function 

1 RD(R) Input Receive data (ring) 

2 RD(T) Input Receive data (tip) 

3 FGND   

4 TD(R) Output Transmit data (ring) 

5 TD(T) Output Transmit data (tip) 

6 FGND   

7, 8 FGND Not connected  
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Canopy BH 
RJ-45 
connector 

Pin 
LAN  
RJ-45 
connector 

Color 

TD+ 1 TD+ White/Green 

TD- 2 TD- Green 

RD+ 3 RD+ White/Orange

Nc 4 Not used Blue 

Nc 5 Not used White/blue 

RD 6 RD Orange 

Nc 7 Not used White/brown 

Nc 8 Not used brown 

 

Figure 12: RJ-45 Ethernet connection pin-outs (LAN side) 

Perform this procedure to connect the cables to the T1/E1 unit. 

Procedure 2: Connecting cables to T1/E1 unit 

1. Connect the T1/E1 cables to the T1/E1 ports. 
NOTE: There is a one-to-one relationship between the T1/E1 ports on the 
Canopy T1/E1 Multiplexer. This means, that the T1/E1 cable connected to the 
T1/E1 Port 1 on one of the Canopy T1/E1 Multiplexers, must also be connected 
to Port 1 on the other. 

2. Connect the Ethernet cables to the Ethernet ports. 
3. Connect the power cable to the power connector. 

 end of procedure 

2.2.5 Connecting Power to the Canopy T1/E1 Multiplexer 
The Canopy T1/E1 Multiplexer is available in two power configurations: 

◦ an external 3.3-v DC power source (supplied by Canopy)  
◦ an external −48 v DC power supply with a terminal strip that plugs into the back 

of the Canopy T1/E1 Multiplexer. 
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WARNING! 
Disconnect power before proceeding.  

 

Follow this procedure to connect the supplied AC adapter (+3.3 v DC power source). 

 

Procedure 3: Connecting the AC adapter (+3.3 v DC power source) 

1. Connect the AC adapter to a surge suppression device that meets the standard 
specified under Power Supply Unit on Page 27. 

2. Connect the surge suppression device to the building AC power source. 
3. Connect the AC adapter to the DC IN port on the rear of the Canopy T1/E1 

Multiplexer. 

 end of procedure 

 

Follow this procedure to connect the to an external −48 v DC power source. 

Procedure 4: Connecting the −48 v DC power source 

 CAUTION! 
Ensure correct polarity before connecting external DC supply to Canopy 
T1/E1 Multiplexer. 

 

1. Connect the power cables to the terminal strip ensuring the correct polarity is 
maintained. 

2. Once the Canopy T1/E1 Multiplexer is mounted in its desired configuration, 
connect the supplied terminal strip to the back of the unit. Do this by slowly 
pushing the terminal strip into the connector on the back of the Canopy T1/E1 
Multiplexer.   
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Figure 13: Rear panel Option 2: −48 v DC polarity 

 
3. Connect the power cables to an external −48 v DC supply.   

 end of procedure 

2.3 INITIAL CONFIGURATION PROCEDURES 

2.3.1 Installing Software from the CD‐ROM 

Procedure 5: Installing Software from the CD-ROM 

Follow these steps to install the software that is provided by Motorola Canopy on the CD-
ROM onto your PC. 

1. Load software onto your PC.   
The T1/E1 Multiplexer EMS Graphical User Interface is provided by Canopy on a 
CD-ROM that is shipped with the unit.  

2. Install the software from the CD-ROM by double-clicking the setup application or  
3. Issue the Start->Run->d:/setup sequence  

where d: is the drive letter of your CD-ROM.  If you are using a different drive 
letter, simply substitute the appropriate drive letter. 

 end of procedure 
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2.3.2 Using EMS Software to Configure the Unit 
An intuitive graphic unit interface (GUI) provides a user-friendly graphical display that 
allows easy-to-follow steps to configure the unit. Fault isolation, statistics and events 
gathering are available. The GUI simplifies field installation. 

Examples of drop-down menus are provided in Figure 14 and Figure 15. 

 

Figure 14: File drop-down menu in GUI 

 

 

Figure 15: Config drop-down menu in GUI 
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2.3.3 Accessing the CLI using a PC + HyperTerminal  
The Command Line Interface (CLI) is accessed using a PC with that includes a terminal 
emulation package such as HyperTerminal®. 

NOTE: The device is only accessible through the serial port. 

2.3.4 Configuring the Canopy T1/E1 Multiplexer using the CLI 
Before you use the CLI to configure the Canopy T1/E1 Multiplexer, you must configure 
the PC serial port.  

Procedure 6: Configuring serial port 

Use this procedure to access the CLI using a terminal emulation program such as 
HyperTerminal.®

1. Connect the serial cable from the DB9 serial port on a PC to the Serial port on 
the Canopy T1/E1 Multiplexer.  The DB9 connector on Canopy T1/E1 Multiplexer 
is female; the cable from the PC is male.  A straight-through cable is required. 

2. Start HyperTerminal or another terminal emulation program. 
3. Set the terminal emulation program to emulate a VT100 terminal with the 

following settings: 
 

Parameter Value 

Bits per second 19200 

Data bits         8 

Parity none 

Stop bits         1 

Flow control none 
 

4. Press Enter.  
The Canopy T1/E1 Multiplexer Login menu is displayed. 
RESULT: The signal port is configured. 

 end of procedure 

 

To use the CLI, select Command Line Interface terminal from the File drop-down menu 
(illustrated in Figure 14 on Page 33). The Command Line Interface window opens, as 
shown in Figure 16. 
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Figure 16: Command Line Interface window 

 

2.3.5 Creating a Login Account 
The system is shipped with default setting for the Administrator account. The account is 
active, but it is recommended you change the password for this account. 
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� 
NOTE: 
The default administrator account username is admin.  
The default administrator account password is 123.  
You cannot change the username. However, you can change the 
password at any time. If you forget your password, reset the system 
back to the default account and password by logging in, using the safety 
account. 
 
The safety account username is safety. 
The safety account password is SAFE_qwe. 
 
When you log in using this account, the password for the administrator 
account is reset to 123.The system will then log you out, at which point 
you may log in using the default administrator account username and 
password. 

2.4 CONFIGURATION PROCEDURES USING THE CLI 

2.4.1 Logging into the System 
To gain access to the CLI, log into the system as described under Configuration 
Procedures Using the EMS. 

2.4.2 Changing the Administrator Password 

Procedure 7: Changing Administrator password using the CLI 

Use this procedure to use the CLI manager to change the Administrator account 
password.  

1. Press Enter. 
2. At the username prompt, enter admin. 
3. At the password prompt, enter 123. 
4. Enter change password. 
5. At the prompt Enter your old password: Password:, enter your old 

password.  
6. At the prompt Enter your new password: Password:, enter your new 

password.  
7. At the prompt Enter your new password: Password:, re-enter your new 

password. 
RESULT: The system responds: Password has been changed. 

8. To log off, enter lo. 
9. Press Enter. 
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10. At the username prompt, enter admin. 
11. At the password prompt, enter your new password. 

 end of procedure 

2.4.3 Select Line Type T1 or E1 

Procedure 8: Selecting line type T1 or E1 using the CLI 

Follow this procedure to select the appropriate line type using the CLI manager. 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Get line type Enter get line type. 
RESULT: The system returns the line type for all four 
ports, as in the following example: 
Line type  [T1/E1] 

Set line type Enter set line type [T1/E1] 
where  
T1 sets the line type to T1 for all 4 ports. 
E1 sets the line type to E1 for all 4 ports. 
RESULT: The system acknowledges the new setting for 
line type for all four ports, as in the following example: 
Line type [T1/E1] 
 

Reset system Enter reset. 
RESULT: The system responds Resetting, then 
immediately resets both Ethernet Interfaces and all 4 
T1/E1 interfaces without asking for a confirmation. 

 CAUTION! 
The previously configured line type 
remains in effect until the system is 
reset. Therefore, this step should 
always be followed by a reset. 

 
 

 end of procedure 
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2.4.4 Select Line Coding 

Procedure 9: Configuring line coding using the CLI 

Follow this procedure to select the appropriate line code using the CLI manager. 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Set line code  Enter set line [1/2/3/4] code [HDB3/B8ZS/AMI] 
where 
HDB3 sets the line type to HDB3 for all 4 E1 ports  
B8ZS sets the line type to B8ZS for all 4 T1 ports. 
AMI sets the line type to AMI for all 4 E1 or T1 ports. 
RESULT: The system selects the line code for all four ports, as in the 
following example. 
Line code [1/2/3/4] set to [HDB3/B8ZS/AMI] 

Get line code Enter get line code. 
RESULT: The system returns the line code for all four ports, as in the 
following example. 
Line code [1/2/3/4] set to [HDB3/B8ZS/AMI] 

 

 end of procedure 

Issue 3 



Canopy  T1/E1 Multiplexer              September 2004 
                        T1/E1 Multiplexer FPGA Version 3.4 

 
 

 

Page 39 of 73 

2.4.5 Configure Ports 

Procedure 10: Configuring the Ethernet ports using the CLI 

Perform this procedure to configure the Ethernet ports using the CLI manager.  

NOTE: Both Ethernet ports operate at 100 Mbps Full Duplex.  They will not operate at  
10 Mbps or at half duplex. 

 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Set BH-side Ethernet auto-
negotiation 

Enter set canopy port auto negotiation [on/off] 
 
where 
on enables auto negotiation at 100 Mbps Full Duplex (as default). 
off forces the port to 100 Mbps Full Duplex without auto negotiation. 
 
RESULT: The system responds 
Canopy port auto-negotiation is: on 
 

Set LAN-side Ethernet 
auto-negotiation 

Enter set lan port auto negotiation [on/off] 
 
where 
on enables auto negotiation at 100 Mbps Full Duplex (as default). 
off forces the port to 100 Mbps Full Duplex without auto negotiation. 
 
RESULT: The system responds 
LAN port auto-negotiation is: on 

Log off Enter lo. 
RESULT: The system responds goodbye. 

 end of procedure 
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Procedure 11: Configuring the T1 ports using the CLI 

Follow this procedure to configure the T1 ports from the CLI manager. 

 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Set T1 line length NOTE: If the incorrect line length is selected, the result could be decreased 
T1 quality or echo on voice lines. The default length is 133 ft. 
 
Enter set line [1/2/3/4] length [133, 266, 399, 533] 
where  
[1/2/3/4] represents T1 ports 1 through 4. 
[133, 266, 399, 533, 655] represents line length in feet. 
 
RESULT: The system responds 
Line [1/2/3/4] length  [0-133 / 0.6 dB; 133-266 / 1.2 
dB; 266-399 / 1.8 dB; 399-533 / 2.4 dB; 533-655 / 3.0 
dB] 

 

Set T1 line code NOTE: If the line code does not match the incoming T1 settings, then Bipolar 
Violations (BPVs) will occur. The default code is B8ZS. 
 
Enter set line [1/2/3/4] code [B8ZS/AMI] 
where  
[1/2/3/4] represents T1 ports 1 through 4. 
[B8ZS/AMI] represents the line coding scheme. 
 
RESULT: The system responds 
Line [1/2/3/4] code [B8ZS/AMI] 
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Action Steps 

Set timing mode  NOTE: Timing mode applies to all four T1 lines. Loopback mode loops the 
T1/E1 Tx clock to the T1/E1 Rx.  Recovered mode recovers the T1/E1 clock 
from the incoming T1/E1 over Ethernet bit stream (recovers the clock from 
the far end T1/E1). The default timing mode is Recovered. 
 
Enter set clock source [loopback/recovered] 
where  
[loopback/recovered] represents the clock timing mode. 
 
RESULT: The system responds 
Clock source is [loopback/recovered] 

 

Set master clock 
reference line  

NOTE: This is the master clock reference for all four T1/E1 lines.  
The default setting is T1/E1 Port 1. 
 
Enter set master clock reference line [1/2/3/4] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4. 
 
RESULT: The system responds 
Clk ref line; [1,2,3,4] 

 

Set backup clock 
reference line 

NOTE: This is the optional backup clock reference for all four T1/E1 lines.  
The backup clock reference becomes active only when the master clock 
reference line is unavailable. The default setting is T1/E1 Port 2. 
 
Enter set secondary clock reference line [1/2/3/4] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4. 
 
RESULT: The system responds 
Backup clk ref line; [1/2/3/4] 

 

Log off Enter lo. 
RESULT: The system responds goodbye. 

 

 end of procedure 

 

Issue 3 



Canopy  T1/E1 Multiplexer              September 2004 
                        T1/E1 Multiplexer FPGA Version 3.4 

 
 

 

Page 42 of 73 

Procedure 12: Configuring the E1 ports using the CLI 

Follow this procedure to configure the E1 ports from the CLI manager. 

 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Set E1 line length NOTE: If the incorrect line length is selected, the result could be decreased 
E1 quality or echo on voice lines. The default length is 133 ft. 
 
Enter set line [1/2/3/4] length [133, 266, 399, 533] 
where  
[1/2/3/4] represents E1 ports 1 through 4. 
[133, 266, 399, 533, 655] represents line length in feet. 
 
RESULT: The system responds 
Line [1/2/3/4] length  [0-133 / 0.6 dB; 133-266 / 1.2 
dB; 266-399 / 1.8 dB; 399-533 / 2.4 dB; 533-655 / 3.0 
dB] 

 

Set E1 line code NOTE: If the line code does not match the incoming E1 settings, then 
Bipolar Violations (BPVs) will occur. The default code is HDB3. 
 
Enter set line [1/2/3/4] code [HDB3/AMI] 
where  
[1/2/3/4] represents E1 ports 1 through 4. 
[HDB3/AMI] represents the line coding scheme. 
 
RESULT: The system responds 
Line [1/2/3/4] code [HDB3/AMI] 
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Action Steps 

Set timing mode  NOTE: Timing mode applies to all four E1 lines. Loopback mode loops the 
T1/E1 Tx clock to the T1/E1 Rx.  Recovered mode recovers the T1/E1 clock 
from the incoming T1/E1 over Ethernet bit stream (recovers the clock from 
the far end T1/E1). The default timing mode is Recovered. 
 
For master clock timing mode, enter  
set clock source loopback 

RESULT: The system responds 
Clock source is loopback 

 
For slave clock timing mode, enter  
set clock source recovered 

RESULT: The system responds 
Clock source is recovered 

 

Set master clock 
reference line  

NOTE: This is the master clock reference for all four T1/E1 lines.  
The default setting is T1/E1 Port 1. 
 
Enter set master clock reference line [1/2/3/4] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4. 
 
RESULT: The system responds 
Clk ref line; [1,2,3,4] 

 

Set backup clock 
reference line 

NOTE: This is the backup clock reference for all four T1/E1 lines.  The 
backup clock reference becomes active only when the master clock 
reference line is unavailable. The default setting is T1/E1 Port 2. 
 
Enter set secondary clock reference line [1/2/3/4] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4. 
 
RESULT: The system responds 
Backup clk ref line; [1/2/3/4] 

 

Log off Enter lo. 
RESULT: The system responds goodbye. 

 

 end of procedure 
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2.4.6 Configure Timing 
Before the timing may be configured, you need to determine the network timing scheme 
to be used.  You also need to identify the master and slave devices for the end-user PBX 
equipment.  

Procedure 13: Configuring timing using the CLI 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Set master clock 
reference line  

NOTE: This is the master clock reference for all four T1/E1 lines.  
The default setting is T1/E1 Port 1. 
 
Enter set master clock reference line [1/2/3/4] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4. 
 
RESULT: The system responds 
Clk ref line; [1,2,3,4] 

 

Set backup clock 
reference line 

NOTE: This is the optional backup clock reference for all four T1/E1 lines.  The 
backup clock reference becomes active only when the master clock reference 
line is unavailable. The default setting is T1/E1 Port 2. 
 
Enter set secondary clock reference line [1/2/3/4] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4. 
 
RESULT: The system responds 
Backup clk ref line; [1/2/3/4] 
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Action Steps 

Set timing mode  NOTE: Timing mode applies to all four E1 lines. Loopback mode loops the T1/E1 
Tx clock to the T1/E1 Rx.  Recovered mode recovers the T1/E1 clock from the 
incoming T1/E1 over Ethernet bit stream (recovers the clock from the far end 
T1/E1). The default timing mode is Recovered. 
 
For master clock timing mode, enter  
set clock source loopback 

RESULT: The system responds 
Clock source is loopback 

 
For slave clock timing mode, enter  
set clock source recovered 

RESULT: The system responds 
Clock source is recovered 

 

Log off Enter lo. 
RESULT: The system responds goodbye. 

 

 end of procedure

2.5 CONFIGURATION PROCEDURES USING THE EMS 

2.5.1 Logging into the System 

Procedure 14: Logging in using the EMS 

If you are using the EMS to access the system, follow the steps below to log in: 

1. Select the proper COM Port for your PC.   
NOTE: COM1 through COM4 are supported.    

2. Enter the User Name.   
NOTE: The default username is admin. This value cannot be changed.   

3. Enter the Password.   
NOTE: The default password is 123.  If the password has been changed, enter 
the correct password. 

4. Select the Login button to continue with the login.   
NOTE: If the login is unsuccessful, the system will generate a pop-up error 
window. You may return to the Login window to correct the data. 
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Figure 17:  Login dialogue box  

 

Once you are successfully logged in, the T1/E1 Multiplexer EMS Main Menu opens 
(shown in Figure 18). 
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Figure 18: T1/E1 Multiplexer EMS main menu 

 

 end of procedure 

 

� 
NOTE: 
You can access CLI commands by selecting  
File→Command Line Terminal from the EMS Main menu. 
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2.5.2 Changing the Administrator Password  
There is only one account for the Canopy T1/E1 Multiplexer—the administrator account.  
The username may not be changed, however the password may be changed at any time. 

   

 

Figure 19: Change Password dialogue box 

 

Procedure 15: Changing Administrator password using the EMS 

Use this procedure to change the password from the EMS. 

1. Select File→Change password from the main menu. 
RESULT: The Change Password dialogue box opens (shown in Figure 19). 

2. Type the old password, then press Enter or Tab. 
3. Type the new password, then press Enter or Tab. 
4. Enter the new password again, then press Enter or Tab. 
5. To accept, click Change. 

To reject, click Cancel.  

 end of procedure 
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2.5.3 Select Line Type T1 or E1 

Procedure 16: Selecting line type T1 or E1 using the EMS 

Follow these steps to configure line coding for the Canopy T1/E1 Multiplexer from the 
EMS. 

 
NOTE: Selecting either T1 or E1 will configure all 4 channels. 

1. From main menu EMS, select the Configuration (Config) option.  
2. Select Configure Line Type. 

RESULT: The Line Config dialogue box opens. 
3. Click ↓. 

RESULT: The dropdown list to specify the coding technique T1 channel opens. 
4. Click on the appropriate line coding technique for the T1channel being 

configured.  
5. Click on the tab for the next Channel to configure line coding for channel. 
6. To configure the line coding technique for each channel, repeat Steps 3 and 4.  
7. When all channels are configured, select the File→Reset menu option.  

RESULT: A confirmation window pops up.   
8. To reset the system, select Yes. 
9. Select Close.  

RESULT: The dialogue box closes and you are returned to the EMS main menu.  
 end of procedure 

2.5.4 Select Line Coding 

Procedure 17: Configuring T1 line coding using the EMS 

Follow these steps to configure T1 line coding from the EMS. 

1. From main menu EMS, select the Configuration (Config) option.  
2. Select Configure T1. 

RESULT: The  Config dialogue box opens. 
3. Click ↓. 

RESULT: The dropdown list to specify the coding technique T1 channel opens. 
4. Click on the appropriate line coding technique for the T1channel being 

configured. 
NOTE: You must select a coding technique: either B8ZS or AMI. 

5. Click on the tab for the next Channel to configure line coding for channel. 
NOTE: If the system has been reset, clicking the Refresh button will replace the 
displayed values with currently-programmed values. 

6. To configure the line coding technique for each other channel, repeat Steps 3 
and 4.  

7. Select Close to close the dialogue box once all channels are configured.  
RESULT: You are returned to the EMS main menu.  

 end of procedure 
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Procedure 18: Configuring E1 line coding using the EMS 

Follow these steps to configure line coding from the EMS. 

1. From main menu EMS, select the Configuration (Config) option.  
2. Select Configure E1. 

RESULT: The E1 Config dialogue box opens. 
3. Click ↓. 

RESULT: The dropdown list to specify the coding technique E1 channel opens. 
4. Click on the appropriate line coding technique for the E1channel being 

configured. 
NOTE: You must select a coding technique: either HDB3 or AMI. 

5. Click on the tab for the next Channel to configure line coding for channel. 
NOTE: If the system has been reset, clicking the Refresh button will replace the 
displayed values with currently-programmed values. 

6. To configure the line coding technique for each other channel, repeat Steps 3 
and 4.  

7. Select Close to close the dialogue box once all channels are configured.  
RESULT: You are returned to the EMS main menu.  

 end of procedure 

2.5.5 Configure Ports 

Procedure 19: Configuring the Ethernet ports using the EMS 

Follow these steps to configure the Ethernet ports using the EMS 
1. From the Main Menu, select the pull-down menu Config→Ethernet.  

RESULT: The Ethernet Configuration dialogue box opens. 
2. Indicate the appropriate choices by clicking on the appropriate radio buttons. 

NOTE: If you select Auto Negotiation Off, the Ethernet port will be forced to 100 
Mbps full duplex.  

3. When the Ethernet configuration is complete, click OK.  
 end of procedure 

 

Procedure 20: Configuring the T1 ports using the EMS 

Follow this procedure to configure the T1 ports from the EMS. 

1. From the pull-down menu, Select Config→T1. 
RESULT: The T1 Config dialogue box opens. 

2. Click ↓ for Length. 
RESULT: The dropdown list to specify the cable length for the T1 channel opens. 

3. Click on the appropriate line length for the T1 being configured. 
NOTE: An improper length can result in decreased line quality or echo. 
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4. Click ↓ for Coding.  
5. Select the coding technique for the channel. 

NOTE: For T1, you must select either B8ZS or AMI. 
6. Click on the tab for the next Channel to configure. 

NOTE: If the system has been reset, clicking the Refresh button will replace the 
displayed values with currently-programmed values. 

7. Repeat steps 1 and 2 to configure each channel.  
8. Click ↓ for Master Clock Reference Line.  
9. Select which line is to be designated as the master clock line.  
10. Click ↓ for Secondary Clock Reference Line. 
11. Optionally, select which line is to be designated as the backup clock reference 

line. 
12. Click on the radio button to indicate whether the clock source is loopback mode 

or recovered mode. 
NOTE: The clock source applies to all four T1 channels. 
 
Loopback mode loops the Tx clock back to the Rx.   
Recovered mode recovers the clock from the incoming T1/E1 over Ethernet-bit-
stream (from the far end T1/E1). 

13. When all channels are configured, select Close to close the dialogue box.  
RESULT: You are returned to the EMS main menu.  

 end of procedure

 

Procedure 21: Configuring the E1 ports using the EMS

Follow this procedure to configure the E1 ports from the EMS. 

1. From the pull-down menu, Select Config→E1. 
RESULT: The E1 Config dialogue box opens. 

2. Click ↓ for Coding.  
3. Select the coding technique for the channel. 

NOTE: For E1, you must select either HDB3 or AMI. 
4. Click on the tab for the next Channel to configure. 

NOTE: If the system has been reset, clicking the Refresh button will replace the 
displayed values with currently-programmed values. 

5. Repeat steps 1 and 2 to configure each channel.  
6. Click ↓ for Master Clock Reference Line.  
7. Select which line is to be designated as the master clock line.  
8. Click ↓ for Secondary Clock Reference Line. 
9. Optionally, select which line is to be designated as the backup clock reference 

line. 
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10. Click on the radio button to indicate whether the clock source is loopback mode 
or recovered mode. 
NOTE: The clock source applies to all four channels. 
 
Loopback mode loops the Tx clock back to the Rx.   
Recovered mode recovers the clock from the incoming T1/E1 over Ethernet-bit-
stream (from the far end T1/E1). 

11. Select Close to close the dialogue box once all channels are configured.  
RESULT: You are returned to the EMS main menu.  

 end of procedure

 

2.5.6 Configure Timing 
Before the timing may be configured, you need to determine the network timing scheme 
to be used.  You also need to identify the master and slave devices for the end-user PBX 
equipment.  

Procedure 22: Configuring timing using the EMS 

Use this procedure to configure the timing using the EMS. 

1. Select Config→T1 from the pull-down menu. 
RESULT: The T1 Config dialogue box opens. 

2. Click ↓ for Master Clock Reference Line. 
3. Select which line is to be designated as the master clock reference line.  
4. Click ↓ for Secondary Clock Reference Line. 
5. Select which line is to be designated as the secondary clock reference line. 
6. Click on the radio button to  indicate whether the clock source for the T1 unit is 

loopback mode or recovered mode. 
NOTE: The clock source applies to all four T1 channels. 
 
Loopback mode loops the T1 Tx clock back to the T1 Rx.   
Recovered mode recovers the T1 clock from the incoming T1 over Ethernet  
bit-stream (far end T1). 
 

7. When all channels are configured, select Close.  
RESULT: You are returned to the EMS main menu. 

NOTE: If the system has been reset, clicking the Refresh button will replace the 
displayed values with currently-programmed values. 

 end of procedure
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3 MANAGING YOUR CANOPY T1/E1 MULTIPLEXERS 

3.1 REMOTE MANAGEMENT THROUGH CONTROL PORT 
The CONTROL port in the front panel (shown in Figure 6 on Page 14) provides the 
capability to remotely manage the Canopy T1/E1 Multiplexer. To do so requires an 
Ethernet to  
RS-232 converter. An example of such a converter is available at 
http://www.precidia.com/products/product1.html.  

The configuration for remote management is illustrated in Figure 20. 
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Figure 20: Remote management overview 
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3.2 T1/E1 ALARMS 
Each T1/E1 channel has alarms for line code violation (BPV), receive loss of signal 
(LOS), and alarm indication signal (AIS) detection.  

Follow these steps to display the alarms using the CLI.  

Procedure 23: Displaying the alarms using the CLI 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

View T1/E1 Alarms Enter get alarms. 
 
The system responds displays alarms for all 4 T1/E1 ports, as in the 
following example: 
 
Line1:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal Detect: No 
Line2:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal  Detect: No 
Line3:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal Detect: No 
Line4:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal Detect: No 
FPGA: 00 

 

Log off Enter lo. 
RESULT: The system responds goodbye. 

 

 end of procedure 
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Follow these steps to display the T1/E1 alarms using the EMS.  

Procedure 24: Displaying alarms using the EMS 

1. Select the Alarms→T1/E1 Alarms menu.   
RESULT: The T1/E1 Alarms window pops up as shown in Figure 21.   

2. Select the desired T1/E1 Channel (1 through 4).  
  end of procedure 

NOTES: 

1. The T1/E1 alarms will be displayed, with a green light meaning no current alarms 
and a red light meaning that there is a current alarm.  The alarms are also 
displayed in text form: No means that there is not a current alarm. Yes means 
that there is a current alarm.  

2. The Alarms Log window lists alarms that have occurred for all 4 T1/E1s while the 
window is open. An alarm log file is automatically written for all 4 T1/E1s.  The 
file exits in the same directory in which the T1/E1 Multiplexer EMS exists. The 
filename is apt1AlarmsLog.txt. The log file can be written only when the 
T1/E1 Multiplexer EMS is running. 

 

 
Figure 21: Canopy T1/E1 Mux Alarms window 
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3.3 SYSTEM RESET  
Follow the steps below to reset the system from the CLI. 

 

Procedure 25: Resetting the system using the CLI 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Reset system Enter reset. 
RESULT: The system responds Resetting, then immediately resets 
both Ethernet Interfaces and all 4 T1/E1 interfaces without asking for a 
confirmation. 

 

 end of procedure 

 

Follow these steps to reset the system using the EMS. 

Procedure 26: Resetting the system using the EMS 

1. Select the File→Reset menu option.  
RESULT: A confirmation window pops up.   

2. To reset the system, select Yes.   
NOTE: Selecting No cancels the action, and the system will not be reset. 

 

 

Figure 22:  EMS reset confirmation box 

 

 end of procedure 

Issue 3 



Canopy  T1/E1 Multiplexer              September 2004 
                        T1/E1 Multiplexer FPGA Version 3.4 

 
 

 

Page 57 of 73 

3.4 T1/E1 LOOPBACK 
Each of the 4 T1/E1s can be placed in loopback mode for testing and maintenance 
purposes. This provides a bi-directional loopback on the T1/E1 interface. The near end 
T1/E1 Transmit is looped back to the near end Receive, and the far end T1/E1 transmit 
that arrives over the BH Ethernet port is looped back to the far end Receive. 

The T1/E1 loopback remains in effect until the user removes the loopback through the 
CLI or through the EMS, or the system is reset. 

 

 CAUTION! 
Invoking a T1/E1 Loopback will drop voice calls and disrupt user traffic 
flow. 

 

 

 
Figure 23: Canopy T1/E1 Multiplexer in T1/E1 Loopback mode 

 

Issue 3 



Canopy  T1/E1 Multiplexer              September 2004 
                        T1/E1 Multiplexer FPGA Version 3.4 

 
 

 

Page 58 of 73 

3.4.1 Invoking a T1/E1 Loopback using the CLI  
Follow the steps below to invoke a T1/E1 Loopback from the CLI. 

Procedure 27: Invoking a T1/E1 loopback using the CLI 

Action Steps 

Log in Press Enter. 
At the username prompt, enter admin. 
At the password prompt, enter password. 

Set T1/E1 into Loopback 
Mode 

Enter set line loopback [1/2/3/4] [on/off] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4. 
on will enable T1/E1 loopback. 
off will remove the T1/E1 loopback. 
 
The system responds 
Line [1/2/3/4] loopback is: [on/off] 

 

Log off Enter lo. 
RESULT: The system responds goodbye. 

  

 end of procedure 

 

3.4.2 Invoking a T1/E1 Loopback Using the EMS 

Procedure 28: Invoking a T1/E1 loopback using the EMS 

Use this procedure to invoke a T1/E1 Loopback from the EMS. 

1. Select the Test→Loopback menu option.   
RESULT: The Loopback Test dialogue box opens. 

2. Select the target T1/E1 Channel by clicking on the appropriate tab.   
3. Use the On or Off radio button to invoke or remove the T1/E1 loopback.   

RESULT: The Loopback is immediately invoked or removed. 

 end of procedure 
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3.5 MEASUREMENTS FROM DIAGNOSTICS 
A unit-based comparison of diagnostic measurements is provided in Table 13. 

Table 13: Comparison of diagnostic measurements 

Measurement Description Availability Advantage Disadvantage 

Bit errors Logic errors in 
the bit stream 

Only out of 
service 

Best unit for 
point-to-point 
performance 

Requires that all traffic 
be test traffic (known 
data pattern) 

BPVs Pulses of the  
same consecutive
polarity 

In service 
or out of 
service 

Good for circuit
or repeater 
problems 

Meaningful for only 
metallic media, because 
some equipment corrects
BPVs 

Frame errors Incorrect values 
in the framing 
bit position 

In service 
or out of 
service 

Approximates 
bit error rate on
in-service basis

Evaluates only overhead
bits 

CRC errors Bit errors in a 
block of data 

In service 
or out of 
service 

98.4% bit error
rate accuracy 

Available with only ESF 
framing 

 

3.6 FIRMWARE UPGRADES 
Firmware upgrades are periodically made available to enhance performance or to add 
features and functionality to the Canopy T1/E1 Multiplexer. 

Procedure 29: Upgrading firmware 

To install new firmware on a Canopy T1/E1 Multiplexer, perform the following steps. 

1. Close any other applications that are active on the PC. 
2. From the main menu of the EMS, select Config→Software Upgrade (shown in 

Figure 15 on Page 33). 
RESULT: The System Upgrade window opens, as shown in Figure 24. 
 
 

 
Figure 24: System Upgrade window 
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3. Click Browse to find the new FPGA firmware that your authorized Canopy 
distributor or reseller provided. 

4. Select the file to download. 
NOTE: Typically the filename has the format Vx_y.bin (for example, 
V3_4.bin). 

5. Click Download. 
RESULT: The status bar indicates the progress of the download process. 
 

 

IMPORTANT! 
During the download process, do not interrupt the download process. 

6. Wait until the download is complete. 
7. Reset the T1/E1 Multiplexer according to Procedure 26 on 56. 

RESULT: The upgrade process is complete. 
8. From the main menu of the EMS, select Help→About Canopy T1/E1 Mux. 
9. Verify that the intended firmware version is indicated on the screen that results, 

as shown in Figure 25. 
 

 

 
Figure 25: FPGA revision details screen 

 

 end of procedure 
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3.7 LICENSE KEY UPGRADES 
As previously described, you can transform any single-port enabled Canopy T1/E1 
Multiplexer into a 2-port, 3-port, or 4-port multiplexer through the purchase and 
installation of license keys from your Canopy distributor.  

Procedure 30: Installing a license key to enable an additional port 

To install a license key on a Canopy T1/E1 Multiplexer, perform the following steps. 

1. From the main menu of the EMS, select Config→T1/E1 Port Upgrade 
Config→Software Upgrade (shown in Figure 15 on Page 33). 
RESULT: The Canopy T1/E1 Port Upgrade window opens, as shown in  
Figure 26. 

 

  
Figure 26: T1/E1 Port Upgrade window 

 

2. Type in the upgrade key that your Canopy distributor provided for this unit, then 
press Enter. 

3. Click Done. 
RESULT: If the upgrade succeeded, then the Key accepted window appears  
(see Figure 27).  
If the upgrade failed, then the Failed: Invalid key entry window appears (see 
Figure 28). 

 

Figure 27: Key accepted window 
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Figure 28: Invalid key entry window 

 

NOTE: At any later date, you can confirm the number of enabled ports as follows. 

4. From the main menu, select Config→Canopy T1/E1 Mux. 
RESULT: The Canopy T1/E1 Mux Configuration window opens, as shown in  
Figure 29. 

 

Figure 29: Canopy T1/E1 Mux Configuration window 

 

5. In the lower right quadrant of the window, find the Enabled T1/E1 Ports block. 
NOTE: Each enabled port is identified by a black check mark. 

 end of procedure  
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3.8 TERMS OF WARRANTY 

3.8.1 Software License Terms and Conditions 
ONLY OPEN THE PACKAGE, OR USE THE SOFTWARE AND RELATED PRODUCT IF YOU 
ACCEPT THE TERMS OF THIS LICENSE. BY BREAKING THE SEAL ON THIS DISK KIT / 
CDROM, OR IF YOU USE THE SOFTWARE OR RELATED PRODUCT, YOU ACCEPT THE 
TERMS OF THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS, DO 
NOT USE THE SOFTWARE OR RELATED PRODUCT; INSTEAD, RETURN THE SOFTWARE 
TO PLACE OF PURCHASE FOR A FULL REFUND. THE FOLLOWING AGREEMENT IS A 
LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR ENTITY), AND 
MOTOROLA, INC. (FOR ITSELF AND ITS LICENSORS).  THE RIGHT TO USE THIS PRODUCT 
IS LICENSED ONLY ON THE CONDITION THAT YOU AGREE TO THE FOLLOWING TERMS.   

Now, therefore, in consideration of the promises and mutual obligations contained herein, and for 
other good and valuable consideration, the receipt and sufficiency of which are hereby mutually 
acknowledged, you and Motorola agree as follows: 

Grant of License. Subject to the following terms and conditions, Motorola, Inc., grants to you a 
personal, revocable, non-assignable, non-transferable, non-exclusive and limited license to use on 
a single piece of equipment only one copy of the software contained on this disk (which may have 
been pre-loaded on the equipment)(Software). You may make two copies of the Software, but only 
for backup, archival, or disaster recovery purposes.  On any copy you make of the Software, you 
must reproduce and include the copyright and other proprietary rights notice contained on the copy 
we have furnished you of the Software. 

Ownership. Motorola (or its supplier) retains all title, ownership and intellectual property rights to 
the Software and any copies, including translations, compilations, derivative works (including 
images) partial copies and portions of updated works. The Software is Motorola’s (or its supplier's) 
confidential proprietary information. This Software License Agreement does not convey to you any 
interest in or to the Software, but only a limited right of use. You agree not to disclose it or make it 
available to anyone without Motorola’s written authorization. You will exercise no less than 
reasonable care to protect the Software from unauthorized disclosure. You agree not to 
disassemble, decompile or reverse engineer, or create derivative works of the Software, except 
and only to the extent that such activity is expressly permitted by applicable law. 

Termination.  This License is effective until terminated.  This License will terminate immediately 
without notice from Motorola or judicial resolution if you fail to comply with any provision of this 
License.  Upon such termination you must destroy the Software, all accompanying written materials 
and all copies thereof, and the sections entitled Limited Warranty, Limitation of Remedies and 
Damages, and General will survive any termination. 

Limited Warranty.  Motorola warrants for a period of ninety (90) days from Motorola’s or its 
customer’s shipment of the Software to you that (i) the disk(s) on which the Software is recorded 
will be free from defects in materials and workmanship under normal use and (ii) the Software, 
under normal use, will perform substantially in accordance with Motorola’s published specifications 
for that release level of the Software.  The written materials are provided "AS IS" and without 
warranty of any kind.  Motorola's entire liability and your sole and exclusive remedy for any breach 
of the foregoing limited warranty will be, at Motorola's option, replacement of the disk(s), provision 
of downloadable patch or replacement code, or refund of the unused portion of your bargained for 
contractual benefit up to the amount paid for this Software License. 

THIS LIMITED WARRANTY IS THE ONLY WARRANTY PROVIDED BY MOTOROLA, AND 
MOTOROLA AND ITS LICENSORS EXPRESSLY DISCLAIM ALL OTHER WARRANTIES, 
EITHER EXPRESS OF IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT.  MOTOROLA DOES NOT WARRANT THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE 
SOFTWARE WILL BE CORRECTED.  NO ORAL OR WRITTEN REPRESENTATIONS MADE BY 
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MOTOROLA OR AN AGENT THEREOF SHALL CREATE A WARRANTY OR IN ANY WAY 
INCREASE THE SCOPE OF THIS WARRANTY.  MOTOROLA DOES NOT WARRANT ANY 
SOFTWARE THAT HAS BEEN OPERATED IN EXCESS OF SPECIFICATIONS, DAMAGED, 
MISUSED, NEGLECTED, OR IMPROPERLY INSTALLED. BECAUSE SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES, THE ABOVE 
LIMITATIONS MAY NOT APPLY TO YOU. 

Limitation of Remedies and Damages.  Regardless of whether any remedy set forth herein fails 
of its essential purpose, IN NO EVENT SHALL MOTOROLA OR ANY OF THE LICENSORS, 
DIRECTORS, OFFICERS, EMPLOYEES OR AFFILIATES OF THE FOREGOING BE LIABLE TO 
YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, INDIRECT, SPECIAL OR SIMILAR DAMAGES 
WHATSOEVER (including, without limitation, damages for loss of business profits, business 
interruption, loss of business information and the like), whether foreseeable or unforeseeable, 
arising out of the use or inability to use the Software or accompanying written materials, regardless 
of the basis of the claim and even if Motorola or a Motorola representative has been advised of the 
possibility of such damage.  Motorola's liability to you for direct damages for any cause whatsoever, 
regardless of the basis of the form of the action, will be limited to the price paid for the Software 
that caused the damages.  THIS LIMITATION WILL NOT APPLY IN CASE OF PERSONAL 
INJURY ONLY WHERE AND TO THE EXTENT THAT APPLICABLE LAW REQUIRES SUCH 
LIABILITY.  BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU. 

Maintenance and Support. Motorola shall not be responsible for maintenance or support of the 
software.  By accepting the license granted under this agreement, you agree that Motorola will be 
under no obligation to provide any support, maintenance or service in connection with the Software 
or any application developed by you.  Any maintenance and support of the Related Product will be 
provided under the terms of the agreement for the Related Product.   

Transfer. In the case of software designed to operate on Motorola equipment, you may not transfer 
the Software to another party except: (1) if you are an end-user, when you are transferring the 
Software together with the Motorola equipment on which it operates; or 2) if you are a Motorola 
licensed distributor, when you are transferring the Software either together with such Motorola 
equipment or are transferring the Software as a licensed duly paid for upgrade, update, patch, new 
release, enhancement or replacement of a prior version of the Software. If you are a Motorola 
licensed distributor, when you are transferring the Software as permitted herein, you agree to 
transfer the Software with a license agreement having terms and conditions no less restrictive than 
those contained herein.  You may transfer all other Software, not otherwise having an agreed 
restriction on transfer, to another party.  However, all such transfers of Software are strictly subject 
to the conditions precedent that the other party agrees to accept the terms and conditions of this 
License, and you destroy any copy of the Software you do not transfer to that party.  You may not 
sublicense or otherwise transfer, rent or lease the Software without our written consent. You may 
not transfer the Software in violation of any laws, regulations, export controls or economic 
sanctions imposed by the U.S. Government. 

Right to Audit. Motorola shall have the right to audit annually, upon reasonable advance notice 
and during normal business hours, your records and accounts to determine compliance with the 
terms of this Agreement.  

Export Controls.  You specifically acknowledge that the software may be subject to United States 
and other country export control laws.  You shall comply strictly with all requirements of all 
applicable export control laws and regulations with respect to all such software and materials. 

U.S. Government Users.  If you are a U.S. Government user, then the Software is provided with 
"RESTRICTED RIGHTS" as set forth in subparagraphs (c)(1) and (2) of the Commercial Computer 
Software-Restricted Rights clause at FAR 52 227-19 or subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013, as applicable. 

Disputes. You and Motorola hereby agree that any dispute, controversy or claim, except for any 
dispute, controversy or claim involving intellectual property, prior to initiation of any formal legal 
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process, will be submitted for non-binding mediation, prior to initiation of any formal legal process.  
Cost of mediation will be shared equally.  Nothing in this Section will prevent either party from 
resorting to judicial proceedings, if (i) good faith efforts to resolve the dispute under these 
procedures have been unsuccessful, (ii) the dispute, claim or controversy involves intellectual 
property, or (iii) interim relief from a court is necessary to prevent serious and irreparable injury to 
that party or to others. 

General. Illinois law governs this license.  The terms of this license are supplemental to any written 
agreement executed by both parties regarding this subject and the Software Motorola is to license 
you under it, and supersedes all previous oral or written communications between us regarding the 
subject except for such executed agreement. It may not be modified or waived except in writing and 
signed by an officer or other authorized representative of each party. If any provision is held invalid, 
all other provisions shall remain valid, unless such invalidity would frustrate the purpose of our 
agreement. The failure of either party to enforce any rights granted hereunder or to take action 
against the other party in the event of any breach hereunder shall not be deemed a waiver by that 
party as to subsequent enforcement of rights or subsequent action in the event of future breaches. 

3.8.2 Hardware Warranty in U.S. 
Motorola U.S. offers a warranty covering a period of one year from the date of purchase by the 
customer.  If a product is found defective during the warranty period, Motorola will repair or replace 
the product with the same or a similar model, which may be a reconditioned unit, without charge for 
parts or labor.  

IN NO EVENT SHALL MOTOROLA BE LIABLE TO YOU OR ANY OTHER PARTY FOR ANY 
DIRECT, INDIRECT, GENERAL, SPECIAL, INCIDENTAL, CONSEQUENTIAL, EXEMPLARY OR 
OTHER DAMAGE ARISING OUT OF THE USE OR INABILITY TO USE THE PRODUCT 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR ANY OTHER 
PECUNIARY LOSS, OR FROM ANY BREACH OF WARRANTY, EVEN IF MOTOROLA HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. (Some states do not allow the 
exclusion or limitation of incidental or consequential damages, so the above exclusion or limitation 
may not apply to you.) IN NO CASE SHALL MOTOROLA’S LIABILITY EXCEED THE AMOUNT 
YOU PAID FOR THE PRODUCT. 

3.9 OBTAINING TECHNICAL SUPPORT 
To get information or assistance as soon as possible for problems that you encounter, 
use the following sequence of action: 

1. Search this document, the user manuals that support other modules, and the 
software release notes of supported releases 
a. in the Table of Contents for the topic. 
b. in the Adobe Reader® search capability for keywords that apply.2  

2.   Visit the Canopy systems website at http://www.motorola.com/canopy. 
3.   Ask your Canopy products supplier to help. 
4.   View and analyze event logs, error messages, and debug messages to help  
      isolate the problem. 
5.   Check release notes and verify that all of the Canopy equipment are on the 
      correct software releases per the correct software release notes. 

                                                      
2 Reader is a registered trademark of Adobe Systems, Incorporated. 
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6. Verify that the Canopy configuration files match the last known good (baseline) 
Canopy configuration files captured in site log book. 

7. Verify connectivity (physical cabling). 
8. At the SM level, minimize your network configuration (remove home network 

devices to help isolate problem). 
9. Perform the site verification checklist. 
10. Check FAQs to see whether the problem and a solution are present. 
11. Escalate the problem to Canopy systems Technical Support (or another Tier 3 

technical support that has been designated for you) as follows: 
a. Compose e-mail to technical-support@canopywireless.com. In this email 

◦ Describe the problem. 
◦ Describe the history of the problem. 
◦ List your attempts to solve the problem. 
◦ Attach the above files. 
◦ List the files that you are attaching. 

b. Send the email. 
c. Call 1 888 605 2552 (or +1 217-824-9742). 

 end of procedure 

3.10 INVOKING YOUR WARRANTY RIGHTS 
For warranty assistance, contact your reseller or distributor for the process. 
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4 CANOPY T1/E1 MULTIPLEXER REFERENCE 
INFORMATION 

4.1 CLI COMMANDS TO GET STATUS INFORMATION 
 

Desired Action Syntax, Response, and Description 

Get Canopy-side 
Ethernet auto-
negotiation 

Enter get canopy port auto negotiation 
 

The system responds 
Canopy port auto-negotiation is: [on/off] 
 

Gets the auto-negotiation mode for the Canopy BH Ethernet port.  If 
auto negotiation is set to OFF, the port will be forced to 100 Mbps Full 
Duplex. 
 

Get LAN-side 
Ethernet auto-
negotiation 

Enter get lan port auto negotiation 
 

The system responds 
LAN port auto-negotiation is: [on/off] 

 
Get the auto-negotiation mode for the customer LAN Ethernet port.  If 
auto negotiation is set to OFF, the port will be forced to 100 Mbps Full 
Duplex. 
 

Get line type Enter get type 
 

The system responds 
Line type [T1/E1] 

 
Gets the line type, either T1 or E1.  All four ports have the same line 
type. 
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Desired Action Syntax, Response, and Description 

Get T1 line length Enter get line [1/2/3/4] length 
where  
[1/2/3/4] represents T1 ports 1 through 4. 
 
The system responds 
Line [1/2/3/4] length  [0-133 / 0.6 dB; 133-266 / 
1.2 dB; 266-399 / 1.8 dB; 399-533 / 2.4 dB; 533-655 
/ 3.0 dB] 
 

Gets the T1 line length.  The units are in feet in decibels. If the incorrect 
line length is selected, the result could be decreased T1 quality or echo 
on voice lines.  
 

Get T1 line code Enter get code line [1/2/3/4] 
where  
[1/2/3/4] represents T1 ports 1 through 4 
 
The system responds 
Line [1/2/3/4] code [B8ZS/AMI] 
 

Gets the T1 line code. If the line code does not match, Bipolar 
Violations (BPVs) will occur. 
 

Get E1 line code Enter get code line [1/2/3/4] 
where  
[1/2/3/4] represents E1 ports 1 through 4 
 
The system responds: 
Line [1/2/3/4] code [HDB3/AMI] 
 

Gets the E1 line code. If the line code does not match, Bipolar 
Violations (BPVs) will occur. 
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Desired Action Syntax, Response, and Description 

Get the timing mode  Enter get clock source 
 

The system responds 
Clock source set to [loopback/recovered] 
 

Gets the T1 timing mode. This timing mode applies for all four T1 lines. 
Loopback mode means to take the T1 Tx clock and loop it back to the 
T1 Rx.  Recovered mode means to recover the T1 clock from the 
incoming T1 over Ethernet bit stream, in other words to recover the 
clock from the far end T1. 
 

Get the master 
clock reference line 

Enter get master clock reference line 
 

The system responds Clk ref line: [1/2/3/4] 
NOTE: [1/2/3/4] represents T1/E1 ports 1 through 4. 
 
Displays the T1 master clock reference line. This clock reference 
applies for all four T1 lines.  
 

Get the secondary 
clock reference line 

Enter get secondary clock reference line 
 

The system responds Backup clk ref line; [1/2/3/4] 
NOTE: [1/2/3/4] represents T1/E1 ports 1 through 4. 
 
Displays the T1/E1 secondary or backup clock reference line. This 
clock reference is the backup clock reference for all four T1/E1 lines.  
The backup clock reference will become active only when the master 
clock reference line is unavailable.  
 

Issue 3 



Canopy  T1/E1 Multiplexer              September 2004 
                        T1/E1 Multiplexer FPGA Version 3.4 

 
 

 

Page 70 of 73 

Desired Action Syntax, Response, and Description 

View T1/E1 Alarms Enter get alarms 
 

The system responds displays alarms for all 4 T1/E1 ports, as in the 
following example: 

 
Line1:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal Detect: No 
Line2:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal  Detect: No 
Line3:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal Detect: No 
Line4:  
    Line code violation: No 
    Receive Loss of Signal: No 
    Alarm Indication Signal Detect: No 
FPGA: 00 

 

Read Serial 
Number 

Reads the serial number of the Canopy T1/E1 Multiplexer. 

Get T1/E1 
Loopback Mode 

Enter get loopback line [1/2/3/4] 
where  
[1/2/3/4] represents T1/E1 ports 1 through 4 

 
The system responds: 
Line [1/2/3/4] loopback is: [on/off] 
 

Displays the loopback status of a T1/E1 line.   
 

Get Firmware 
Revision 

Enter get firmware revision 
 

The system responds 
Firmware revision is: x.y.z 

 

Gets the revision (version number) of the Canopy T1/E1 firmware. 
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Desired Action Syntax, Response, and Description 

Get FPGA Revision Enter get fpga revision 
 

The system responds 
FPGA  revision is: x.y.z 

 
Get the revision (version number) of the Canopy T1/E1 FPGA. The 
FPGA controls the T1 parameters. 
 

 

4.2 REGULATORY COMPLIANCE INFORMATION 
This section contains information regarding regulatory compliance with the Federal 
Communication Commission, Department of Communications and the European 
Telecommunications Standards Institute applies to the Canopy BH radio link. 

4.2.1 Federal Communication Commission Declaration of Conformity Statement 
This device complies with Part 15 of FCC Rules. Operation is subject to the following two 
conditions:  (1) This device may not cause harmful interference, and (2) This device must 
accept any interference received, including interference that may cause undesired 
operation. 

This equipment has been tested and found to comply with the limits for a Class  A digital 
device, pursuant to Part 15 of FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses and radiates radio-frequency 
energy, and, if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense.  

 

  

WARNING! 
The Part 15 radio device operates on a non-interference basis with the 
other devices operating at this frequency. Any changes or modification to 
said product not expressly approved by Motorola Canopy could void the 
user’s authority to operate this device. 
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4.2.2 Department of Communications – Canada 
Canadian Compliance Statement 

This class B Digital apparatus meets all the requirements of the Canadian Interference-
Causing Equipment Regulations. 

This device complies with RSS-210 of Industry Canada.  Operation is subject to the 
following two conditions: (1) this device can not cause harmful interference; and (2) this 
device must accept any interference received, including interference that can cause 
undesired operation.  

This device is certified to the requirements of RSS-139. The use of this device in a 
system operating either partially or completely outdoors can require the user to obtain a 
license for the system according to Canadian regulations. For further information, contact 
your local Industry Canada office. 

4.2.3 European Telecommunications Standards Institute 
Statement of Compliance 

Information to User 

This equipment has been tested and found to comply with the European 
Telecommunications Standard ETS 300.328. This standard covers Wideband Data 
Transmission Systems referred to in CEPT Recommendation T/R 10.01. 

This type accepted equipment is designed to provide reasonable protection against 
harmful interference when the equipment is operated in a residential environment. This 
equipment generates, uses, and can radiate radio frequency energy, and if not installed 
and used in accordance with the instruction manual, can cause harmful interference to 
radio communications. 

4.3 TRADEMARKS, PRODUCT NAMES, AND SERVICE NAMES 
MOTOROLA, the stylized M Logo and all other trademarks indicated as such herein are 
trademarks of Motorola, Inc. ® Reg. U.S. Pat & Tm. Office.  Canopy is a trademark of Motorola, 
Inc.  All other product or service names are the property of their respective owners. 

Motorola, Inc 
Broadband Wireless Technology Center 
1299 East Algonquin Road 
Schaumburg, IL 60196 
USA 

http://www.motorola.com/canopy
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4.4 REFERENCES 
This document refers to the following documents: 

◦ American National Standards Institute. ANSI T1.101-1999 – Telecommunication 
Synchronization Interface Standards. 

◦ American National Standards Institute. ANSI T1.105.09-1996 – Synchronous 
Optical Network (SONET) Network Element Timing and Synchronization.  

◦ American National Standards Institute. ANSI T1.403-1989 - Carrier to customer 
installation - DS1 metallic interface. 

◦ Cleveland, Robert F., Jr., David M. Sylvar and Jerry L. Ulcek. Federal 
Communications Commission, Office of Engineering and Technology. OET 
Bulletin No. 65. Edition 97-01 (August, 1997). Evaluation Compliance with FCC 
Guidelines for Human Exposure to Radiofrequency Electromagnetic Fields. 

◦ European Telecommunications Standard ETS 300 328, 2nd Edition, (November, 
1996). Radio Equipment and System (RES); Wideband Transmission Systems; 
Technical characteristics and test conditions for data transmission equipment 
operating in the 2,4 GHz ISM band and using spread spectrum modulation 
techniques. 

◦ National Electrical Code (NEC), Chapter 800, Article 810, Radio and Television 
Equipment.  

◦ ITU-T Recommendation G.703 
◦ ITU-T Recommendation G.823 
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